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Chapter 1
DDR Configuration and Validation

This document introduces the double data rate (DDR) RAM configuration and validation tool, which is an embedded
component of QorIQ Configuration and Validation Suite (QCVS).

The DDR tool has two components: DDR configuration tool and DDR validation tool. The DDR configuration tool allows you
to create a configuration for the DDR component and the DDR validation tool allows you to validate the DDR configuration
using various validation scenarios.

This chapter is divided into the following sections:

• DDR configuration on page 3

• DDR validation on page 21

1.1 DDR configuration
This section describes how to create a new QorIQ configuration project, how to configure the DDR component, and how to
perform some basic operations using the DDR configuration tool.

The DDR configuration tool inside the QCVS configures the DDR controller embedded in various supported QorIQ/Qonverge
device families.

The DDR configuration tool provides a user-friendly graphical interface to configure the DDR controller. It can be used for
tweaking some of the configuration parameters when you want to use different DDR Dual In-line Memory Modules (DIMMs)
than the ones received with the board or when you want to optimize the DDR configuration.

While configuring DDR, you can view register values of the DDR controller. The register values will be exported by the DDR
tool into C, TCL, or GDB code. After configuring the DDR controller, you can generate code that will fit easily into your software
environment in the following ways:

• OS-agnostic low-level C source code that configures the DDR controller(s) registers' values.

• C source code that outputs the register values in the format required by U-Boot. This file can replace an existing file
inside uBoot.

• Source code in DDR related part of the CodeWarrior target initialization file *.tcl. The code in this file can be used
inside CodeWarrior projects.

This section contains the following subsections:

• Using DDR configuration tool on page 3

• Importing DDR configuration on page 13

• Exporting DDR configuration on page 20

1.1.1 Using DDR configuration tool
The DDR configuration tool helps you configure the DDR controller in a QorIQ processor, based on the DDR
implementation (discrete or DIMM) used in the processor.

The DDR implementation may differ by various parameters, such as number of chip selects, memory size, or ranks
interleaving. To configure a new DDR controller, you need to use the specifications from the DDR manufacturer data sheet
and fill the values in the interface. The DDR parameters are grouped together by functionality.

This section contains the following subsections:

• Create a new QorIQ configuration project on page 4

• Configure DDR controller on page 6
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• Generate code from DDR component on page 12

1.1.1.1 Create a new QorIQ configuration project
To use the DDR configuration tool, you first need to create a QorIQ configuration project with DDR configuration.

To create a new QorIQ project for DDR configuration, follow these steps:

1. Select File > New > QorIQ Configuration Project. Follow the steps in the New QorIQ Configuration Project wizard.

2. Enter project name.

3. Select the required target SoC.

4. On the Toolset selection page, select the DDR Memory Controller Configuration checkbox.

Figure 1. Toolset selection page

5. Click Next. The DDR Configuration page appears.

• To configure the DDR with DIMM settings, select the DIMM option.
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Figure 2. DDR configuration for DRAM module

• For designs that utilize embedded, discrete devices, select the Discrete DRAM option.
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Figure 3. DDR configuration for discrete DRAM

6. Click Finish to complete project creation.

This creates a QorIQ Configuration project for DDR configuration.

1.1.1.2 Configure DDR controller
After creating a QorIQ configuration project with the DDR toolset, you can configure the DDR controller using the DDR
configuration tool.

Perform the following steps to configure DDR controller:

1. Select the DDR component under the Components folder in the Components view, as shown in the following figure.
The properties of the DDR component opens in the Component Inspector view.

 

If the Component Inspector view is closed, you can open it by right-clicking the DDR component

in the Components view and then selecting the Inspector option from the pop-up menu.

  NOTE  
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Figure 4. Select DDR component in Components view

 

You can add multiple DDR components to a project. Each DDR component maps to one or two

DDR controllers that the QorIQ silicon has. For example, P4080 SoC has two embedded DDR

controllers, so if you want to configure both of them, add two DDR components from the

Components Library to the project, one component for each controller. Right-click the DDR

component in the Categories tab and select Add to project with Wizard from the pop-up menu,

as shown in the following figure.

  NOTE  
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Figure 5. Add DDR component to project

2. Modify the following basic DDR parameters according to your requirements.

• Memory type - specify the memory type: DDR2 (supported only by some of the SoCs), DDR3 or DDR3L

Figure 6. Set memory type

• DIMM Type - specify the DIMM type: Unbuffered or Registered

Figure 7. Set DIMM type

• DDR Bus Clock - for each DDR bus clock, there is a specific bus clock frequency that measures the duration of a
bus clock cycle.
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Figure 8. Set DDR bus clock

• Timing Configuration 1 - set four basic DDR timings: tCL, tRCD, tRP, tRAS specified usually as tCL-tRCD-tRP-
tRAS. The timings are measured in bus clock cycles.

Figure 9. Set timing configuration 1

• Chip Select 0, 1, 2, 3 - specify the number of physical ranks or chip selects. A DIMM can have 1, 2 or 4 ranks and
are specified in the basic DIMM information as 1R ... or 2R... or 4R. For this, from the four chip selects, enable the
ones that correspond to the ranks (each chip select corresponds to one rank). Also, set size of the DIMM. The size is
configured inside each chip select. For example, a 2GB dual-ranked DIMM will have its size split evenly between the
two ranks, so each chip select will have 1 GB in size.
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Figure 10. Set chip select / physical ranks

3. Set rest of the parameters from the DDR vendor's datasheet. The DDR vendor's datasheet is available on the
manufacturer's website.

 

For each step of the configuration process, you might receive validation errors for some specific

parameters along with information on how to fix the validation conflict.

  NOTE  

You can import register values of the DDR component from a memory dump, containing the values of the DDR memory-
mapped registers. Memory dumps can be obtained from U-Boot (using the md command) or CodeWarrior (using the Export
registers/memory feature).

1. Select the Import tab in the Component Inspector view.
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Figure 11. Import tab - DDR component

2. Specify the location of the input file in the Input File field. The red mark denoting an error/conflict disappears.

3. Select the file format parameters from File Format drop-down list.

4. Specify the valid address information of the memory dump file in the Beginning memory address field. The red mark
denoting an error/conflict disappears.

 

The red marks indicate errors, therefore, before clicking the Import button, make sure that all the

red marks disappear.

  NOTE  

5. Click Import. The input file is imported.

6. Click OK in the Import complete dialog.

Figure 12. Import complete dialog

7. Open the Problems view to see reported errors if any.

 

You can also configure the DDR component while creating the QorIQ project. On the DDR

Configuration page (see Figure 3. DDR configuration for discrete DRAM on page 6), select the

appropriate option, Auto configuration or Import from memory file, and provide the necessary

details corresponding to the selected option.

  NOTE  

DDR Configuration and Validation

DDR configuration

QCVS DDR Tool User Guide, Rev. 4.7, 10/2016
NXP Semiconductors 11



1.1.1.3 Generate code from DDR component
After you finish configuring the DDR controller, you can generate code from DDR component to get updated output of the
component.

The source code generated from the DDR component helps you configure the DDR controller registers and it can be used
in the CodeWarrior projects.

The code generation from the DDR component is based on the properties set in the Component Inspector view. The output
from the DDR component is generated on user request.

Perform any of the following steps to generate code:

•
Click the Generate Processor Expert Code icon  in the Components view, as shown in the following figure.

• Right-click the ProcessorExpert.pe node in the Project Explorer, as shown in the following figure.

• Select the Project > Generate Processor Expert Code option from the Eclipse IDE menu.

Figure 13. Generate Processor Expert code

The Generating Code dialog appears.
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Figure 14. Code generation

The output file is generated and placed in the Generated_Code folder of the Project Explorer. The name of the output file
is set according to the DDR component name used in the QorIQ Configuration project, as shown in the figure below.

Figure 15. DDR-generated code file in Project Explorer

1.1.2 Importing DDR configuration
The DDR tool allows you to import a memory dump, which can be in a format, such as U-Boot, S-Record, AnnotatedHex,
Signed/Unsigned decimal, CodeWarrior Regs, Hex, or Raw Binary.

The memory dump is decoded into a DDR configuration, which then can be visualized, validated, and adjusted, if required.

To import a DDR configuration, a QorIQ Configuration project must be created. You can import the DDR configuration during
project creation or later for any component already added to the project. Perform the following steps:
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1. On the DDR Configuration page of the New QorIQ Configuration Project wizard (shown below), select the Import
from memory file option.

2. Specify the memory dump format to be imported in the Input file text box.

Figure 16. Selecting input file for DDR configuration

3. Click Finish. The DDR project is created.

4. Open the Component Inspector of the DDR project.

5. Select the Import tab and set the following parameters as shown in the following figure:

• Input file: Specify the file which encapsulates the memory dump

• File Format: Select the supported format of the memory dump. Ensure that you correlate the chosen file format with
the selected input file. If the file content is not in accordance with the chosen format, the import operation will fail and
an error message will pop up.

You can also import a DDR configuration from the target board by choosing Import from target from the File format
menu. This action only works if an active and working connection is configured in the Connections View (see Set up
target connection on page 26 for more information). If such a connection exists, the DDR tool reads the DDR registers
from the board and populates the active component with the data read. Note that this type of action is relevant only if
the DDR registers were previously configured (for example, by U-Boot).

• Endian mode: Specify the order of the bytes

• Beginning memory address: Specify the start address of the memory dump. This is fixed and bound to the devices
HW specifications.
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• DDR controller memory address: Specify the beginning address of the memory mapped DDR registers inside the
memory dump. It can be overridden by clearing the Use default checkbox.

Figure 17. Component Inspector - Specifying import parameters

This is how you import a DDR configuration.

 

While performing the import operation during project creation, you can configure all the DDR

controllers. Choose the current DDR controller from the Configure list on the DDR Configuration

page (see Figure 16. Selecting input file for DDR configuration on page 14). If you are importing

from Component Inspector for DDR, you import only for the selected DDR controller.

  NOTE  

This section contains the following subsections:

• Memory dump formats on page 15

• Get memory dump formats on page 18

1.1.2.1 Memory dump formats
This section describes the different memory dump formats available for importing.

The various memory dump formats available for importing are shown in the following figures.

• AnnotatedHex: In this format:

• The first line contians start address of DDR memory controller (FE008000)

• Each line contains four registers, each of them is a 32-bit register

• First four registers are: CS0_BNDS, CS1_BNDS, CS2_BNDS, CS3_BNDS

DDR Configuration and Validation

DDR configuration

QCVS DDR Tool User Guide, Rev. 4.7, 10/2016
NXP Semiconductors 15



Figure 18. AnnotatedHex memory dump format

• S-Record: You can find detailed information at http://en.wikipedia.org/wiki/SREC_(file_format)

Figure 19. S-Record memory dump format

• Signed/Unsigned Decimal: The difference between Signed and Unsigned is that the former has a decimal number with
a sign while the latter contains a decimal number without a sign.
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Figure 20. Signed/Unsigned Decimal memory dump format

• CodeWarrior Regs: It is the CodeWarrior-specific memory dump format. Such a dump can be obtained from a
CodeWarrior product (PA, ARMv7, or ARMv8) by exporting the DDR registers (using the Register View dialog) into XML
format.

Figure 21. CodeWarrior Regs memory dump

• Hex: Contains a list of hex-formatted values where four consecutive lines form a register value.
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Figure 22. Hex memory dump format

• Raw binary: It is a binary file. It represents a stream of hex values in a binary format, and four consecutive values form a
register value.

Figure 23. Raw Binary memory dump format

1.1.2.2 Get memory dump formats
Using CodeWarrior, you can get a memory dump format from the DDR controller registers of a board.

The DDR configuration tool allows you to import, view, and then configure the DDR controller registers of a board. The DDR
controller registers can be downloaded from the board in a memory dump format using a dump utility provided by Freescale's
CodeWarrior Development Studio.

To get a dump from a memory controller using Code Warrior, you can add a Import/Export task, as shown in the figure below,
using the new Target Tasks panel. Select the Export Memory option, specify the start and end memory address from where
to read the registers, and enter the file name where to put the dumped registers. For a detailed description of the export
memory dump, see the product documentation of CodeWarrior Development Studio v10.x for Power Architecture.
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Figure 24. Export data from memory into file

You can also generate the CodeWarrior register dump format to obtain the memory dump file at runtime. Open the Registers
view, select the DDR controller registers, and click the Export registers button, as shown in the figure below.

Figure 25. Export registers button

The Export Registers dialog appears. Set the parameters and click Finish. The CodeWarrior memory dump file will be
generated.
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Figure 26. Export Registers dialog

1.1.3 Exporting DDR configuration
The DDR configuration tool allows you to export memory dump, which can be in a format, such as S-Record,
AnnotatedHex, Signed/Unsigned decimal, CodeWarrior Regs, Hex, or Raw Binary.

The DDR configuration is exported as a memory dump that can be shared with others and/or imported into the tool later.

To export a DDR configuration, create a QorIQ Configuration project. You can export the DDR configuration for any component
already existing in the project. Click the Export tab and set the following parameters:

• Output file: Specify the file where you will write the memory dump

• File format: Select the supported format of the memory dump into which you want to export the DDR configuration

Figure 27. Component Inspector - Specifying export file
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1.2 DDR validation
This section describes the DDR validation (DDRv) tool and explains how to use the tool to validate and optimize a DDR
configuration using different validation scenarios.

The DDR validation tool can be used to validate a DDR configuration either created using memory specifications or read
from a memory dump or target. The validation process is performed in stages, by gradually refining an initial DDR configuration
up to an optimal configuration. Each validation step is responsible with the verification and optimization of specific DDR
parameters. The outcome of a validation stage represents the input to the next one; therefore, gradually refining the DDR
settings.

You can intervene in the validation stages and decide whether to include or skip a stage depending on which DDR settings
are important with respect to optimization. DDRv is built as a multi-tier software comprised of an Eclipse-based UI, a validation
service that can be used from a remote location, and a target connection layer. The Eclipse user interface enables you to
configure, control, and monitor the DDR validation process as well as view and interpret the results. The validation service
allows you to run DDR validation on a target whether directly accessible through a target probe or indirectly through a remote
computer. The connectivity layer facilitates the communication with the target using Common Debug Development
Environment (CDDE). CDDE is a software package working on the top of CodeWarrior Connection Server (CCS) that enables
target operation via Python scripting. CDDE and CCS packages are bundled into the QCVS layout. They are also distributed
with CodeWarrior for Power Architecture, ARMv7, and ARMv8 products.

DDRv is a licensed product; therefore, it requires a valid license. See Licensing on page 38 for more information related to
licensing.

This section explains:

• Overview of DDR validation UI on page 21

• Using DDR validation tool on page 26

• Advanced DDR validation operations on page 35

• Licensing on page 38

1.2.1 Overview of DDR validation UI
This section describes the different elements of the DDR validation user interface.

The Component Inspector view displays a dedicated page, named Validation, for the validation of a DDR component. The
Validation page, shown in the figure below, represents the GUI of the DDR validation tool.

 

A working target connection is mandatory to run DDR validation. For instructions to set up a target

connection, see Set up target connection on page 26.

  NOTE  
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Figure 28. Validation page

 

To validate DDR using an existing QorIQ configuration project that does not have a DDR

component, add a new DDR component to the project from the Components Library.

  NOTE  

The subsections below explain the different panels of the Validation page:

• Validation scenarios panel on page 22

• Validation control panel on page 23

• Test configuration panel on page 23

• Scenario results panel on page 23

• Validation page toolbar on page 25

1.2.1.1 Validation scenarios panel
The validation scenarios panel lists the predefined DDR validation scenarios.

A scenario represents a test approach for testing DDR. A scenario takes a DDR configuration as input, applies changes to
it, verifies each change against several tests, and delivers an optimal DDR configuration. A particular case is the Operational
DDR tests scenario, which takes the newly created DDR configuration as input and verifies it against several tests without
applying any changes to it. The scenarios are grouped into two stages: Validation and Margins.

Usually, a scenario takes the following form:

• It modifies the input DDR configuration by programming the DDR controller memory-mapped registers with a different set
of values. This results in a set of derived DDR configurations.

• Each derived DDR configuration is tested against several types of tests. Depending on the scenario, you can select the
tests from a predefined list or the tests are automatically selected by the tool.

• The test results are displayed in a tabular format, with each cell in the table representing a derived DDR configuration. The
results indicate which parameters are varied and how they are varied as well as an overview of the passed/failed DDR
configurations.

• After completion of all the tests, an optimal DDR configuration is determined that represents the input to the next scenario
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To access any of the derived configurations (including the optimal configuration), click the

corresponding cell. This loads the corresponding DDR configuration. You can export the DDR

configuration to a file or obtain DDR initialization code out of it.

  NOTE  

1.2.1.2 Validation control panel
The validation control panel allows you to control the validation process.

You can control the validation process to start, stop, pause, or resume it. This is performed by two buttons, Start Validation
and Pause that are present above the target connection panel.

1.2.1.3 Test configuration panel
The test configuration panel allows you to configure the validation tests.

The DDRv tool provides several predefined tests, some of them are configurable. To achieve the optimal DDR configuration
for each scenario, a test can be run multiple times. You can choose and configure the tests you want to run for a scenario,
using the Choose Tests page (some scenarios do not have configurable tests to choose from). You can add your own tests
using Add custom test button located in the right upper side of the tests list. When you add a new test to the list, a default
test is created using a template that you have to fill in with your own DDR testing code. The code has to be written in Python
syntax.

You can remove or rename the user-defined (custom) tests using a context menu of each test. Any test from the list can be
viewed by double-clicking it. The test content is displayed in a new window. You can modify the test content and also see the
DDR default test scripts.

1.2.1.4 Scenario results panel
The scenario results panel summarizes the results of the validation tests.

It is located in the center of the Validation page inside the Results page. It is organized into two sections: high-level summary
and detailed summary. The high-level summary is organized into one or more tables that show the following:

• All the variations of the scenario's input DDR configuration. Each input derivative is abstracted as a cell.

• The validation progress while it is running

A variation table is a visual representation of how the input DDR configuration for a scenario varies while the scenario runs.
The validation progress is displayed using colors and numbers. The color code helps in visualizing the results of the executed
scenario. The colors and numbers are decoded as follows:

• The current cell that is being tested flashes

• The cells, which are being validated displays the number in fraction. The numerator represents how many tests have
passed, while the denominator represents how many tests were run for that cell

• Each cell is colored based on the validation result (see the figure below):

• Red: Indicates that validation failed for the cell due to target connection issues or unknown causes

• Yellow: Indicates that validation failed for the cell because it could not pass some tests

• Orange: Indicates that validation failed for the cell due to incorrect DDR configuration

• Light green: Indicates that the cell passed all tests

• Bright green: Indicates that the cell has optimal DDR configuration

 

In case of multiple errors, the color code displayed for a cell corresponds to the most critical error

occurred for the cell during the test iterations. The order of criticality from high to low is: red, yellow,

orange.

  NOTE  
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Figure 29. Cell color code

The detailed summary displays detailed information about the cell selected in the high-level summary. The information is
organized into three pages:

• Summary page: Shows the DDR configuration register values that were updated for the selected cell along with the detailed
status (queued, passed, failed, or skipped) and error register values for each test execution

• Logs page: Displays the execution log for each test execution, redirected from CDDE log. You can use this log to understand
why a test failed or passed.

• Scripts page: Shows the exact Python scripts that were executed on the target using CDDE. You can open a script in a
separate editor by clicking the Open in editor button, located at the top-right corner of the Scripts page.

The figure below shows the detailed summary.
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Figure 30. Results page

The high-level and detailed scenario execution summaries are available during and after the scenario has executed. The
information is updated as the scenario execution progresses.

1.2.1.5 Validation page toolbar
The Validation page toolbar allows you to perform different operations before or during DDR validation.

The figure below shows the options on the Validation page toolbar.

Figure 31. Validation page toolbar options

You can perform the following operations using the Validation page toolbar options:

• Schedule report generation: Using a toolbar option, you can make validation reports generated based on a schedule.
This option is available only before the validation starts.

DDR Configuration and Validation

DDR validation

QCVS DDR Tool User Guide, Rev. 4.7, 10/2016
NXP Semiconductors 25



• Revert to the initial DDR configuration: Using a toolbar option, you can revert the DDR configuration to the last known
default configuration used in a previous validation. This option is available only before the validation starts. It is useful
when running the validation multiple times over the same DDR configuration.

• Toggle between the Basic and Advanced validation modes: Using a toolbar option, you can toggle between the Basic
and Advanced validation error view modes. This provides improved viewing of the validation failures that helps in
determining the failure cause quickly.

• Choose the DDR parameters to test: You can choose which DDR parameters to test using one of the three icons on the
toolbar: choose all, an area, or none. This option is useful when you want to perform a quick test of a specific variation
without waiting for the full set to be tested.

1.2.2 Using DDR validation tool
This section explains how to use the DDR validation tool to perform validation of a DDR component.

Performing DDR validation involves the following operations:

• Set up target connection on page 26

• Set up remote configuration on page 29

• Choose validation scenarios and tests on page 30

• Customize validation tests on page 30

• Run validation on page 32

• Report validation results on page 33

• Set DDR validation preferences on page 34

1.2.2.1 Set up target connection
The DDRv tool requires a working target connection and a target connection provider that facilitates the connection with
the target.

The target connection provider can be either CDDE or GDB (both are bundled into QCVS layout).

The DDR validation uses a client–server architecture to allow validation on both local and remote systems. If you have a
target board connected to your computer using a probe, then you can validate it locally. By default, validation is performed
on the local system.

With a new DDR project, a default target connection is created using a CodeWarrior TAP probe with empty connection string.
The Read from SPD option requires a probe and a connection string. A target connection is required for reading from SPD
and the DIMM vendor parameters. You can set up (create new, edit, or delete) a target connection using the Connections
View.

To open the Connections View, follow these steps:

1. Choose Window > Show View > Other. The Show View dialog appears.

2. Choose Processor Expert > Connections and click OK. The Connections View appears, as shown in the figure
below.
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Figure 32. Setting up target connection

As you can see in the figure above, the Connections View displays the Active target connection menu at the top for
choosing the active target connection. A connection status indicator is displayed next to the Active target connection menu
that indicates whether or not the active target connection is working properly. A connected chain indicates a working
connection and a broken chain with an error icon indicate a failed connection. Each time you choose a different connection
from the Active target connection menu, the connection gets verified and its status is indicated by the connection status
indicator.

At the bottom, the Connections View displays a menu that allows you to specify whether the target hardware is accessed
from a local computer or a remote computer. In case the target hardware is accessed from a remote computer, then you also
need to specify the IP address of the remote computer and connect it to the target hardware.

At the middle of the Connections View, you can see a connections table, which shows the details of all the available
connections. You can also see the New, Edit, and Delete buttons for creating a new connection and editing or deleting the
connection selected in the connections table.

To create a new connection, follow these steps:

1. Click the New button in the Connections View. The New connection dialog appears, as shown in the figure below.
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Figure 33. Creating a new connection

The New connection dialog allows you to define a connection name, target device to connect to, and the probe (Ethernet
TAP, Gigabit TAP, or CodeWarrior TAP) to be used. Depending on the probe you have selected, you need to specify the
appropriate connection string. For example, in the connection string, you need to specify:

• IP address for Ethernet TAP

• IP address and tag for Gigabit TAP

• ID or IP address for CodeWarrior TAP

2. Specify the details for the new connection in the New connection dialog.

3. Click Save.

To edit an existing connection, follow these steps:

1. Select the connection in the connections table available in the Connections View.

2. Click the Edit button. The Edit connection dialog appears, as shown in the figure below.
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Figure 34. Editing a connection

3. Modify the details of the connection.

4. Click Save.

1.2.2.2 Set up remote configuration
The DDRv tool allows you to connect to a remote target that is neither connected directly to the user's computer nor
accessible using a remote probe, such as Ethernet TAP, Gigabit TAP, or CodeWarrior TAP.

This capability allows validation of a DDR configuration defined on a user's computer, on a target that is connected to another
computer with an IP address visible from user's computer. For example, you have DDRv installed on your computer and
would like to connect to a remote target, which is connected using a locally-visible probe to a computer that you can access
using its IP address.

Perform the following steps to validate DDR as described above:

1. Install CDDE service on the remote machine to which the target is connected. CDDE is included in the installation layout
of CodeWarrior for Power Architecture in the <CW_INSTALLATION_DIR>\PA\cdde folder.

2. From the local machine where DDRv is installed, copy <INSTALL_DIR>\eclipse\Optimization\remote-service and
<INSTALL_DIR>\eclipse\Optimization\target-connection folders on the remote machine. This represents the
binaries of the connection management process required for running DDRv.

3. Start the connection management process by double-clicking the
com.freescale.processorexpert.validation.service_<plugin_version>.jar file. This file is present in the DDRv
installation layout in the <DDRV_Installation_DIR>\eclipse\Optimization\remote-service folder. An icon appears
in the taskbar that indicates that the Connection Manager is up and running.

Figure 35. Connection Manager icon
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To use the remote setup, you need to enter the IP address of the computer, the target is connected to (see Set up target
connection on page 26 for more information).

1.2.2.3 Choose validation scenarios and tests
After the tool is successfully connected to a validation server, you can choose the validation scenarios and tests that will
be run during the validation of the DDR component.

You can choose:

• Which scenarios will be run: You can select the scenarios you want to run, using the left pane of the Validation page of
Component Inspector (see the figure below). At least, one scenario needs to be selected. If multiple scenarios are
selected, then they will run, one by one.

• Which tests will be run for a scenario: After selecting a scenario, you can select the tests you want to run for that
scenario, using the Choose Tests page on the right pane of the Validation page (see the figure below and Customize
validation tests on page 30)

• Which of the derived DDR configurations will be tested (all, some, or none)

Figure 36. Choose validation scenarios and tests

1.2.2.4 Customize validation tests
You can select a set of tests you want to run for a validation scenario.

To access the tests, go to the Choose Tests tab (see the figure below) located on the Validation page of Component
Inspector. In the Choose Tests tab, you can:

• Select or deselect what tests will be run for a selected scenario

• Update the number of repetitions for each test (by selecting the test and typing a new value in the cell under the
Repetition column)

• Add custom tests

• Remove or rename a custom test (by right-clicking the test)
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• Edit the existing test script content (by double-clicking a test)

Figure 37. Choose Tests page

Some tests can only be selected for some particular scenarios. The set of tests for a validation scenario depends on:

• The validation scenario

• The device whose DDR is being validated

Some of the tests have customizable parameters. Those parameters depend on the test type, and you can modify them within
several constraints. Whenever a constraint is broken, you will be notified about it using an error decorator on the UI.

Besides the standard tests provided by the tool, you can add your custom tests to the list of tests (see the figure below). A
custom test consists of a template (a Write-Read-Compare template) that you can further enhance. Similar to standard tests,
custom tests can be added, removed, or selected to be run for a validation scenario. The DDR tool provides the following
additional options related to tests:

• You can select each test (standard or custom) to be run multiple times for a scenario

• You can use for all scenarios the set of tests you selected for a scenario
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Figure 38. Customizing tests for a validation scenario

1.2.2.5 Run validation
When one or more test scenarios are selected, the Start Validation button gets enabled. You can click this button to start
the validation of the DDR component.

A validation starts executing various configurations with each combination represented as a cell in the Results table as shown
below. For example, you select the Centering the clock scenario and BIST and Walking Ones as tests. The Centering
the clock scenario varies the CLK_ADJ and WRLVL_START DDR controller parameters. When this scenario runs, the
chosen tests are run for each of the two parameter variations.

Figure 39. Results page

When the validation step for the scenario is finished, the Results table shows whether or not the test passed. In addition,
the bright green cell, which corresponds to the optimal DDR configuration, is automatically selected.

Before proceeding to the next validation step (that is the next test scenario), the tool applies the DDR configuration
corresponding to the bright green cell of the last executed test scenario. In case none of the cells has passing configurations,
then you should restart the validation step. In case there are few passing cells but you are not satisfied with the automatic
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selection of the bright green cell, then you can select a different passing cell to have its configuration applied for the next
validation step.

1.2.2.6 Report validation results
After or during the validation, you can save the validation results for a scenario in a format, such as PDF, XLS, or CSV.

To print the results in a format, use the action buttons shown in figure below.

Figure 40. Report validation results

In addition, you can set up a reporting job to auto-generate reports at different events, such as scenario completion or
periodically after some time.

Figure 41. Auto-generate DDRv report

The report is generated periodically with all the validations executed until that time. Adjust the report generation settings, if
needed.
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Figure 42. On demand report

1.2.2.7 Set DDR validation preferences
This section explains you how to specify your preferences for using the DDR validation tool.

The Preferences dialog now has a page, DDR validation, which allows you to specify your preferences for using the DDR
validation tool. To open the DDR validation page, follow these steps:

1. Choose Window > Preferences. The Preferences dialog appears.

2. Expand the Processor Expert node and click DDR validation. The DDR validation page appears, as shown in the
figure below.

Figure 43. DDR validation page
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1.2.3 Advanced DDR validation operations
This section explains some advanced DDR validation operations using some example use cases.

The section is divided into the following subsections:

• Using Read from SPD option on page 35

• Customizing validation code on page 36

• Using read/write data bus margin scenario on page 37

1.2.3.1 Using Read from SPD option
Read from SPD is an option of configuring the DDR according to the DIMM vendor recommendation.

This option allows you to configure DDR quickly and helps you determine an optimized DDR configuration in less time. The
steps to configure DDR are as follows:

1. Select an update package from the Configure drop-down list.

2. Select the Configuration mode as Read from SPD.

Figure 44. Read from SPD

3. Choose the debug device from the Probe menu and specify the probe ID or IP address in the text field.

4. Click the Read SPD link. In the text box, a message is displayed indicating whether or not serial presence detect (SPD)
is read successfully. Disabled parameters are read from SPD.

5. Click Finish. This button will be enabled if SPD is read successfully.

The read SPD information is used to create the DRAM part of a DDR configuration. Later on, you can view what has actually
been read from SPD using the following steps:

1. Finish creating the DDR component using the Read from SPD mode.

2. Go to the DDR component and open it in Component Inspector.

3. Select Serial Presence Detect > SPD Data on the Properties page.

4. Click where you are instructed to (go to the second table column, and then click the (...) button) and a new window
opens on the right side. In that window, complete information about SPD is displayed, with the SPD fields on the left
column and their values on the right column, as shown in the figure below. For some fields, multiple values have been
provided by the vendor; such values are separated by a comma.
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Figure 45. Read and/or apply SPD

5. Click the Apply SPD button to apply the SPD settings on the current DDR configuration.

1.2.3.2 Customizing validation code
This section describes customization of the code provided by the DDR validation tool.

The DDR validation tool communicates with the target using CDDE. The actual communication is facilitated by Python
extensions built on the top of CDDE, which allows you to execute target operations using Python scripts.

The DDR validation tests run as applications on the device cores; therefore, their customization is hidden. However, the pre
and post validation operations (for example, target reset, applying the DDR configuration, and clearing the error debug
registers) can be customized as they are written in Python. Such customization could take the form of additional operations
required at reset.

In case, such customizations (for example, performing an RCW override operation before target reset happens) are needed,
you have the option to adjust the code provided by the DDR validation tool. The Python scripts used by DDRv are located at
<INSTALL_DIR>\Optimization\resources\QorIQ\DDR\templates\init\ folder.

For customization, you need a basic understanding of the target operations that are exposed via Python extensions (for
example, memory/register read, write, target reset, and so on). For details, see the <INSTALL_DIR>\Optimization\docs
\PythonScripting.html file.
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1.2.3.3 Using read/write data bus margin scenario
This section describes a DDR validation scenario provided by QCVS: read/write data bus margin.

The validation process for the read/write data bus margin scenario involves the following operations:

1. The read or write margin validation scenario allows the memory controller to complete its normal initialization process
and perform the normal operation.

2. The timing location of each strobe corresponding to its data byte lane (golden value) is stored.

3. The scenario sweeps the strobe signal in the data eye for each byte lane, using small timing steps. At each timing step
during the sweep:

• Randomly generated data is transferred via DMA engine from one memory space in DDR to another and values at the
destination are compared with generated data to determine if the test is passed or failed.

• When the DMA test is passed, the corresponding cell/step is marked as passed and is displayed as green cell in the
generated margin table.

• When an error is detected, the cell is marked as failed and is displayed as white cell in the margin table.

4. After all data byte lanes have gone through this process and have determined the passed and failed cells, then the location
of strobe where memory controller was selected during its initialization process (that is, golden value) is added to the
margin table.

 

Not all QorIQ families support this feature. If the scenarios described here are not visible in your

DDRv GUI, then it implies that the DDR controller in the processor you are working with does not

support this feature (the support has not yet been added to QCVS for these scenarios for that

particular processor). The QorIQ processors (B4/G4/T) were the first ones to support this feature.

  NOTE  

Every time the read or write margin test is run, the memory controller is initialized at the start. The resulting display is a
reconstructed margin data eye, including the strobe signal crossing location within the data eye. A simple visual inspection
of location of strobe with the reconstructed margin data eye will show the number of timing steps before a failure could occur.
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Figure 46. Interpretation of results of a read or write margin scenario

In the figure above, each cell in each lane column shows a combination of two digits. The first digit indicates the number of
tests passed. The second digit indicates the total number of tests conducted.

The size of each step can be calculated by dividing the data rate unit interval by the number of cells between the two blue
lines that indicate the start and end of the theoritical maximum data eye size.

For additional details about the margin scenarios, see QCVS FAQ Guide.

1.2.4 Licensing
The DDR validation tool is a licensed software.

When QCVS is installed over CodeWarrior for PA/ARMv7/ARMv8, the CodeWarrior license file is used. When installed with
Eclipse, a license file must be copied into the <INSTALL_DIR>\eclipse\ProcessorExpert\ folder. See QCVS Installation
Guide for more details on different ways of installing QCVS.

In case a license file is not found, the needed license key does not exist or has expired, or the license server is not responding,
then such details are displayed on the Validation page of Component Inspector for the DDR component (see the figure
below).
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Figure 47. Validation page - License error

In case you get a license error, you can perform one of the following steps:

• Get a new license. Use the provided link to go to the appropriate web page and request for a license.

• Apply an existing license. Click the Browse button, choose the license, and apply it. You might be asked to restart the
tool.
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